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GETTING STARTED -
SETTING UP YOUR TEAM






TEAMS - GETTING STARTED

A Team is a collection of people within an organization who work closely to get things done.

Channels are created within a Team, as places for conversations or work for specific projects or sub-teams within the larger Team.

Getting your Team set-up

1. Submitrequest form to createa new Department/ Project / Group Team
Add membersto join your Team (direct add, invite link, or share team code)
Create Channels for specific topics, projects or teams within the larger Team
Set-up MS Teams Training sessions (UBC IT Okanagan Engagement Services)

Ensure everyoneis to Teams Only mode (to access all features) —automatically
done after May 31, 2021 (click image for more details)
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https://ubcca.sharepoint.com/:u:/r/sites/M365LearningPortal/SitePages/New-Employee-Team-Request-Form.aspx?csf=1&web=1&e=Okd7Sh

HOW TO REQUEST A NEW TEAM

--\ -y

: 1

To createa Team at UBC you need tosubmita Departmental Team ’E__' I I
Request Form forStaffand Faculty (1. Clickon GetStarted attopleftside, Q }s---,

2. Clickon “Help and Feedback” on thetop menu, 3. Clickon “Request a

Team”)
You will need: f""""""\
* |AMShortCode andIAM Display Nameto completethe form (linkto : :
thisis provided ontheform —or canalsobefoundbylooking atyour | :
profilein Outlook). : e I
i
* FortheTeam Name, pleaseconsider usingthe followingnaming ‘\____________/

convention:

0 [IAM Display Name] [Name] Example: UBC IT ABC123 Project
0 Note: Teamowners CAN change the Team name afterit is created

* Itisrecommendedto have a minimum of two owners per Team AND
Channel (you will need to provide theirname or UBC email -
firstname.lastname@ubc.ca). I"--I

- -

\ 4

Oncevyour Teamiscreated, you will receivean email with acodeto share
with those who wanttojoin, or you canadd people directly.

Note: By default, only Ownersof a Team can create new channels (general
or private), however this can be changedvia the Team settings so that
members can createtheirown channels.


https://ubcca.sharepoint.com/:u:/r/sites/M365LearningPortal/SitePages/New-Employee-Team-Request-Form.aspx?csf=1&web=1&e=Okd7Sh

HOW TO ADD MEMBERS

SR iE:
---------- \
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MANAGE TEAM SETTINGS R

Members  Pending Requests Channelsl Settings Ipps 1 more ~
‘ LB N | ’

» Team picture Add a team picture

+ Member permissions Enable channel creation, adding apps. and more

Allow members to create and update channels

Allow members to create private channels

Allow members to delete and restore channels

Allow members to add and remove apps

Allow members to upload custom apps

Allow members to create, update, and remove tabs

Allow members to create, update, and remave connectors

Owners can delete all messages

Give members the option to delete their messages

e e 0 O d O O 0B O

Give members the option to edit their messages

Members

* View, add and/or change owners & members
Settings

* Change who can create / delete channels, private channel

creation, tab creation in channels, edit or delete content



MANAGE PERSONAL SETTINGS

* Change Teamsview (and other settings) — Grid or List View

1

s

To Change Teams Layout
1. Clickonyour profile at the top

right corner OR the three dots
next to the Search Bar

2. Select “Settings” from the drop
down menu

Under “General”, select Layout, either

* GRID (display a single Team and Channel
atatime)—-0OR
 LIST (see all Teams and Channels you

belong to)

GRID

LIST
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MANAGE PERSONAL NOTIFICATIONS

To Change Personal

Settings & Notifications

1.

Click on your profile
at the top right
corner OR the three
dots next to the
Search Bar

Select “Settings”
from the drop

down menu

Privacy

1.

Enable certain people to contact you even
when your status is DND

Choose whether people can seeyou’ve read
a message in Chats (and see when they read
yours)

N otifications

Receive emailsabout Teamsactivity
Managevisualand audionotices
Managenoticesin Teamsvs Channels
Manage Chat notifications

Manage Meeting activity & notices

Get notified of status for specificpeople

A A
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CREATING & USING
CHANNELS



CREATING CHANNELS*

|”

 All Teamsareautomaticallygivena “General” channel

(thiscannotbe deleted).
e To Createa NEW Channel*:

1) click the three dots next to Team name,
2) Select Add Channel

* Channelscanbe createdwith a Privacy Setting of either

e Standard(accessible to EVERYONE on the team) or \

* Private (only available to members of the Team specified
by Channel owners)

* For Private Channels you should have at least
TWO Owners

* Private channels have less functionality than
standard ones

 NOTE: These settings CAN NOT be changed afterthe
channelis created

*Note: by default, only Owners can create Channels unless this is changed in “Team Settings”

14



CHANNELS - VIEWS & NOTIFICATIONS

 [fyourTeams viewis setto “List” (see
thisslide) you can Pinimportantchannels
to find them more easily

* Youcan Hidechannelsyoudon’tneedto

see, or unhide (see Hidden channels)

* Youcan manageyour notifications by

channelas well, using Channel

Notifications




COMMUNICATING IN CHANNEL POSTS & CHATS

@mentioning
* Youcan usean @ mentionto make sure a particular person gets
notified of your message.

* Justtypethe @ symbol anywhere in your message (in a Channel

post, Chat or Document Conversation) and then start typing a

person’sname, channel name, tag or team name. Thenyou can
select from the suggestions list to mention them.

e The personwill get a notification depending on their setting, it
will appear in their activity feed and they will see a red circle
with the @ symbol next to the post where they were

mentioned.

Liking a chat or post

« Acknowledgethatyou’veread a message oragree without

havingto type a reply. Hover over a message and click on the

thumbs up or othericon.



FORMATTING POSTS & CHATS

Add Formatting

Make your post stand-out by adding text formats including bold, highlighter, change
text size and color, add headings, tables, bullets and more.

Click in the A with paintbrush icon at the bottom left corner of a new post to open the

formatting options.
You can add a post to multiple channels (1) and select who can reply to the post (2) or

click thethree dots at the top right (3) to see more formatting options

Announcement Style

If you want the message to really stand out, select Announcement @)m top left
corner instead of Conversation. This will add a header block which can be a solid color,
illustration or uploaded image.
You can still modify who can reply and post to multiple channels.
For extra attention, add “Important Flag” oy
or mention @Channel _Name or @Team_Name to ensure people see the postin their
Activity Centre and/or whatever other notifications they have set up.

=

Channel was mentioned.

3

= Bulleted list

i= Numbered list

17 Quote

&2 Link

¢/> Code snippet

= Insert horizontal rule

B Insert table

! Remove important flag
2 Undo typing

C* Repeat typing

17



USING TAGS

Tags let users quickly and easily connect with a subset of peopleon ateam. You can create and assign customtags
to categorize people based on attributes, such as role, project, skill, or location.

Afteratagisadded toone or multipleteam members, it can be used in @mentions by anyone onthe Teamin a
Channelpostortostarta Chat with onlythose people whoareinthattag.

0 Note: tagscannotbe used in Private Channels (with lock icon next to Channel name). FPrivate &

e To managewhocan create andedit Tagsfor your Team, click go to
“Manage Team” (seethisslide)

e Tocreateoredit Tags, clickthe threedotsto theright side of the Team
name (1) thenselect “Manage Tags” (2) from the drop-down menu

e Fromthiswindow youcan Createnew tags (1), view existing Team tags (2)
and view tags you belongto (3)




BOOKMARK / SAVE POSTS & CHATS

* Youcan bookmarkany message(in Chator
Channel Posts) soit’s easy to find lateron.

* Clickon the threeellipseinthe top left
corner of the message and select Save this

message.

* To find saved /bookmarked messagesyou

can either:

See your saved list

O go to the search bar at the top of Teams,
type: /saved and you will see a list of
saved items

O Click on your Profile Image at the top right
corner of Teams, and then select “Saved”
from the pop-out window




ADDING NEW TABS TO A CHANNEL

A channel hastwo tabs only by default: Posts & Files. Additional tabs can be
added to create quick access toimportant files, applications or even
websites related to the channel.

* Note:Bydefault onlyOwners can do this, or you can enable this for all

channel members under the Settings for the Team (see THIS SLIDE).

There are two ways to add a tab:

1. Clickthe + symbol (1) to see a selection of apps available for UBC (to

request more apps fill out the Feedback Form). Helpful appsinclude:

* OneNote—See THIS SLIDE for more details on using OneNote.

*  Website—add a URL to link directly to a website such as Workday or a
departmental website.

*  Whiteboard— collaborate or draw / take notes in real time
2. Fromthe “Files” section — SEE HERE for more details.
When you select an application to add as a tab, you can also:

* click “About” (2) to see more details about the application

* Check the box at the bottom (3) to post to the Channel about the new
tab

The new tab will now show at the top of the channel next to Files (4)

* You canclick and hold on any tab to change it’s position (Posts and Files
can NOT be moved).

R

I @ Post to the channel about this tab ' 3

Posts

Files Whiteboard -+

4
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ADD A ONENOTE NOTEBOOK TO A CHANNEL

To add a new or existingOneNote notebooktoa channelin
Microsoft Teams, select Add a tab (1) atthe top of the
channeland select OneNote.

From there, choose an option:

*To startfrom scratch, select Create a new notebook (2), add
a nameto the Notebook name field, and click Save.

*To add an existing notebook (3), select from a list of
notebooks available, choose the notebook and/or section (or
Createa New Section), and select Save.

eTo add a linkto an existing notebook, select Paste a
OneNotelink (4), add the address, and select Save.

You can check the box at the bottom (5) to post aboutthe
notebookto the channel.




ONENOTE & TEAMS

* WhenanewTeam iscreated, a OneNote Notebook is created for

that team. You can add a OneNotetabina channel and create a

Section specificto that Channel (for meeting notes, etc).

e |fyouarea memberofa Team, and use OneNote, the Notebook

will be automatically added to your OneNote collection.

* You can edit pages within Teams (in achannel) oropenitina

Browser orin your Desktop (thisis recommended if you wantto

enable more features like add meeting details, change privacy

setting etc.)

e Torestrictaccesstocertainsections,

o
0
o
0]
o

open the desktop version of OneNote

Right click on the section you want to restrict access
Select “Password Protect This Section”

Set a password and share with relevant people as needed

You can change Password setting including how long sections stay
unlocked by going to File > Options > Advanced > Passwords.

Notebooks

H Drive My
MNotebook

ServiceNow
MNotebook

My Notebook

UBCO-OKIT UBC |

IT Okanagan N...
My Notebook

UBCO IT Moves
Notebook

UBCO-UR

Webcare Group ... N

. Rename

lay, O

Export...

Delete

Move or Copy...

Merge inte Another Section...
Copy Link to Section

Mew Section

Mew Section Group

Mark az Read

By )P FEXT

Section Color 13

{ ﬂ Open in Browser

Open in Desktop App

o This section is password
protected.

Click here or press ENTER to unlock it.

Protected Section X

Section "TEST 27 is password
protected.

Enter Password:

|
(i3

You can change how quickly OneNote
locks protected sections in File >
Options > Advanced category.
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CREATING & SHARING
FILES IN TEAMS



HOW TO CREATE A FILE IN TEAMS

* InaChannelgotothe Filestab (1)andselect “+ New” (2) to create a new
file in the team, then select the type of file you want to create.

*  Youcan edit the file directly in Teams (and others who are part of that
channel will also be able to access and edit the same filein Teams in real

time as well).
* Oryoucanselect Openin Desktop to edit directly in your desktop version

of the application. /




PIN OR ADD FILES AS A TAB

To accessimportant or commonly used files more

quickly you can Pin them to the top of the file list, or

Add them as a Tab to the top of the Channel side

menu.

* GotoaChannel.

* GototheFilessectionfor that Channel.

* Selectthefile or folder you want to pin or make a
tab (2 options):

0 Clickthecircle (1a) totheleft of the filenameto
activate the check symbol

. Fromthe menubaratthetop, select
either “Make this a tab” or “Pin to top”
(2a)
0 Clickonthethreedotstotherightofthefile
name (1b)toopenanew menu.

* Fromthepopupwindowthatappears,
select either “Make this a tab” or “Pin to
top” (2b)

25



COLLABORATING ON FILES

Using Conversation

* Ifyoueditthefilein Teams, you can use
the Conversation feature to add a Post in
the channel related to the document and
tag people as needed (e.g. to request
people toreview or edit a document)

0 (Note — sometime the “conversation” button
disappears, if so, try closing the file thenre-
opening itin the Teams Channel)

0 Conversationis different from Comments
* Click onthe Conversation icon at the top

right of the file to open the Conversation
bar on the right side of the document
(only available while editing in Teams)

* Add yourcommentor request, using @ to
mention specific people or tags.

e Thecommentwill be added tothe
document conversation AND appear as a
post in the channel with an easy image of
the doc to directly link to the file.

S |

----,

\
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COLLABORATING ON FILES - CONVERSATION

* Private Channels—youcan only use Conversation with other members of
the Channel the file was created in (because it will appear in the Posts
section of the Channel)

 |fsomeonerespondstoyouina documentand uses @ your name to tag
you, you will receive an email notifyingyou of the commentwith a link to
the file.

 Ifyouopenthe filein yourdesktoporin a browser, you will not be able to

r--

see the Conversation anymore, however you can

still see and make Comments (under the

“Review” section of the top menu bar).
« “CatchUp” —If youare editinga documentin Teams, if you click on “Catch
Up” at the topright side you’ll see all activityin the document since you

last opened it.




COLLABORATING ON FILES — USING COMMENTS

* To makea Commentina document openin Teams, click on the speech
bubbleicon (1) at the top of the menu bar.

* The Commentdialogue box (2) willopen on theright side of the
document and acommentbubble (3) will be inserted wherever the
cursoris (you can highlighta group of text tocomment on a broader
section of the document).

* Toviewthecomment, clickonthe speech bubble, then you can reply,
edit or delete / resolve the comment.

* Youcan @mentionanyone at UBC even if they are nota member of
your Team or the Channel, however they will not be able to access
the document ifit has not been shared with them.

0 They will be notified via an email that you have mentioned them with
a link to the document. If they don’t have permission they will be
given the option to request permission

O THIS SLIDE has details on how to manage file permissions
* You cantell othersareinthesame document when you see a colored

cursor—hovering over it will show the persons name.

* You will see their edits appearliveinreal time.




COLLABORATING TIPS

 |Ifyoueditadocumentwithin Teams, changes are saved automatically and show
upin real time;

O You can also see the edits from othersinreal time and tell thatothers are
viewing and/or editing the document (colored lines will appear to show where
their cursorisinthe document,and if you hover your mouse over the line their
name will appear)

 Ifyoufileisopenedinyour desktop, you may needto refresh yourchanges

(clicksaveat topleft corner) before changesare visible to others.

Check Out Function

* |fyoucheck outa document, even though others canview it, they will not be ~
ableto editit until youcheckit backin.

 To checkoutafile, hoveroverthe document tofind the ellipsis (show actions) = /
and click on that, find the option “More” and then click on the check out !
function.

* To checkina document, gotothe “More” option and select CheckIn. You will be
given the option of leavinga comment before you checkthe document backin.

29



COLLABORATING ON FILES - PROTECT DOCUMENTS (IN TEAMS)

From Teams

Open a file from within Teams (1 ->2->3),
then click on “File” (4) from the top left menu
bar.

Select “Info” (5) from the far left side menu,
then click on “Protect Document” (6) to turn
off/on opening the document in “view-only”
mode by default to prevent accidental editing
When view mode is selected, the Protect
Document box will change to say “this
document has been set to open as view-only”
(7)

You can click on this box again to toggle it off

(and open documentsin regular edit mode).

=
O !
[

'--'

|
---'

et

Protect Document

To prevent accidental changes, this document has been set to

open as

view-on

ly.

30



COLLABORATING ON FILES— PROTECT DOCUMENTS (DESKTOP)
0

- - -

From Desktop App

Opening afile in the desktop app will give you greater

options and functionality than editing within Teams.

* Openthefileinthe desktop app (open the file in [_}

Teams then select “Open in Desktop App 1->4) 9
* Thenselect “Info” (5) from the left side menu, and

then select Protect Document (6). 9 E:::}

* This will open a pop-up window with more options

to protect the document. G



COLLABORATING ON FILES— VERSION HISTORY (IN TEAMS)

Version history

You can view the version history of files and revert

back to an earlier versionto recoverif needed. You

can also see who made the edits for each version.

In Teams

* Openthefile, clickon File from the top left
menu bar (see previous slides)

e Select “Info” (1) from the side left menu then
select “Version History (2)

* Clickonthe versionyou want(3), you will
then have the option to (4) Restore the
document to that version or Saveitasa copy

0 Note:you willonlyhavealimitedoptionof
locationsto save thefileto, soif youwantto
storeitina differentfolderyou shouldopen
thedocumentin Sharepointorinthe Desktop
App formore options

32



COLLABORATING ON FILES— VERSION HISTORY (DESKTOP APP)

Version history

You canview the version history of filesand revert
backtoanearlierversiontorecoverif needed. Youcan
also seewho made the editsforeach version.

From the Desktop App

Openthefileinthe desktop app (see previous
slides)

Clickon Filefrom thetop menu (far left)

Select “History” fromthe left side menu

Thiswill openthe documentagainwith a new side
barwindow on therightsidelistingall the previous
versions, times & datesthey were savedand by
whom.

You canthenselectaversionbyclickingonatime
and user.

Thiswillopenanew window withthe previous
version (inreadonly mode). Atthetop willbe an
optionto compare or restore the document. You
canalso Select “File” fromthetop menuand then
“Save As” to savea copy of the versioninstead.

History

Current version

Today, 10:12 AM

Saved by: Trifunov, Erin

March 29, 2021
3:53 PM

Saved by: Trifunov, Erin

3:51 PM

Saved by: Trifunov, Erin
3:43 PM

Saved by: Trifunov, Erin
March 19, 2021
9:55 AM

Saved by: Trifunov, Erin
March 18, 2021

2:45 PM
Saved by: Odlum, Trevor




SHARING DOCUMENTS - EDITING IN TEAMS N2

Documentscreated or uploadedtoina Channelin Teams (accessed underthe

“Files” headingin the channel),areowned by & accessibleto allmembersof I

L

™
|

that Channel (if the Channelis publicitis owned andaccessible by all members
of the Team)

To manage sharing permissions while editing In Teams:

* Openthefile, clickon “File” from thetop menu (far left side) then select
“Share” from the left side menunearthe bottom, andthen clickon “Share
with People” atthetop right.

* Thedefaultsettingistosharethelinkwith “People with existingaccess”
(i.e.members of the Channel), however you canchange this by clicking the
down arrow

* Youcangiveaccesstoanyoneat UBCor select specificpeople (using
names, group or emails)

* Youcanalsospecifywhatlevel of accesstheycan have (viewonlyor edit
access)

NOTE: To manage the sharing settingsin more detail open the file or folder in
Sharepoint to see more options for managing sharing permissions andfile
management (movingfilestoo) —see THIS SLIDE for details



SHARING DOCUMENTS—- EDITING IN DESKTOP

* Tomanage sharing permissions for files openedin your Desktop:

0 Openthedocumentinyourdesktop, click on “File” from the
top menu (far left side) then select “Share”

0 Toshare with specific people, click on “Share with People”

e Youcansee who already has access and give
individuals either edit or view access.

*  Youalso have the optiontosendan email with alink to the
document (if

* Ifyouwant to manage the sharing settings in more details open

files or folders in Sharepoint to see more options for managing

sharing permissions and file management (moving files too)

35



USING SHAREPOINT

All Teams created in MS Teams also have a Sharepoint Site created for the Team. This is where all files created within Channels of that Team

are saved (filesin Chat are stored in the OneDrive of the person who created them).

To open Files in Sharepoint, open the Files section of a Channel.

* Thenyoucaneither:
m 2) Select an individual file to open in SharePoint by
clicking on the three dots to theright of the file name,
then click on “Openin SharePoint” from the pop-window

that opens.

1) openthe entire folder of files for that Channel by clicking on
“Openin SharePoint” from the top menu

36



USING SHAREPOINT - CONT’D

From the SharePoint siteyou

have the abilityto view and

manage more specific details

for the files and foldersin

Teams including:

- Stopsharing with allusers

- Copyalinktogiveaccessto
specificpeople or anyone at
UBC

- Changeaccessby group (can
edit, view only, stop sharing)

It is also easierto move files or
copy filesto other Channels
and Teams you area member
of




USING CHAT



USING CHAT

Createa New Chat

Click on the icon with a pencil overa square to
starta new chat (1)

You can chatwith a single person, or multiple
people usingnames, email, group name or

1
Chat v W rrf”

|

- >

2 To: Enter name, email, group or tag ‘

To: engage

Lok E :
2N ngagement Services (UBC IT Okanagan)
—p 3 people will be added
~ —I

tag(2)(seethisslide for details on creating Tags)

If you createa chat with multiple people, you
can create a Group Name for the chat make it
easierto find.

Add Peopleto an Existing Chat

Click on the peopleiconon thetop rightside of
the chat window (1).

Add a person’sname, email or tag.

Select how much chat historythe added person
will haveaccess to (no previous history, #
number of daysor ALL chat history)

| Engagement Services (UBC IT Ckanagan) |

r._
U

1
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MORE CHAT FEATURES

Send Urgent Chat Notifications - Click the exclamation point
below the message box before you press send to mark a

message as important.
* Ifyouselect “Urgent” the recipient will get notifications

every two minutes for the next 20 minutes or until it’s read.

* Ifyouselect “Important” a red header will be added and an
exclamation symbol will be tagged on the message.

Other Chat Options —click the three dots to the right of the

person’sname in your Chat list:

* Popoutchat—toopenthechatinanew pop-outwindow

* Pin—to keepthe chat (meeting, individual or groups) at the
top of your Chat list

* Notify whenavailable—select thisto be notified when their
statusis set to “Available” (green circle)

223 PM o

IMPORTANT!
This message has been marked "Important” (TESTING ONLY) ©

40



SEARCH & FILTER CHATS

Filter Chats

You can use the Filter to search for your chats from a specific person
group or meeting.
* At thetop of your Chat list click on the “filter” icon.

* You canthen search by
0 Contact or Group name (“Filter by Name”), OR

0 glick on the three dots at the right side of the search bar to filter
y
* Unread,
* Meetings or
e Muted chats

Searchin a Chat or Channel Post

 Use Ctrl+F (cmd+F on macOS) to search messages within a
particular chat or channel in Teams. While in the desired Channel
or Chat, type Ctrl+F followed by your search terms, then press
Enter. All the search results will be displayed from within that
chat or channel conversation.

* Youcanalsotype “/find” in the search bar at the top of Teams,
select a Channel, Person, Group or Meeting and then the search
terms.

41



SHARED FILES IN CHAT

Share Filesin a Chat

In a chat (individual, group or meeting) you can

sharefiles which get kept within the chat history.

* Clickthe paperclipiconinthe message window,

to sharefilesfrom your computer, or OneDrive.

 The filewillappearinthe Chatsection, as well as

inthe Files section.

 Fileswill be savedin the OneDrive of the person
who shared the file (in a folder called Microsoft
Teams Chat Files)

42



HOW TO DELETE FILES SHARED IN CHAT

Wi ithin OneDrive

1.

Open your OneDrive folder (click on the cloud icon (1) at
the bottom right side of your screen), then select “Open
Folder” (2)

Open the “Microsoft Teams Chat Files” Folder

Select the file you want to delete, then right-click your
mouse over the file you wish to remove and select
“Delete” from the pop-up window.

Within Chatin Teams

1.

Gotothe Chatsection, and find the message where the
file was shared.

Hover your mouse over the message window (1) until a
pop-up window appears with emojis and three dots (2)
(NOT the three dots next to the file name) then select
“Delete” (3).

The message with the previously deleted file will now say
“This message has been deleted” with an option to Undo.

This message has been deleted. Undo

Home Share View

&«

Facilities
P_ N ¥

“ 4 <« OneDrive - The University Of British Columbia »

Engagement Services

-
Microsoft Teams Chat Filesl

i ot et M ol

Uy

~

MName

|&] Tshifts
@5 UBCO ITMDB to SN Mapping
B3 UBCO ITSC SA Interviews October 2020

Microsoft Teams Chat Files

Open
MNew
Print
)a Open with Code

& Share
View online
Version history
Always keep on this device

Free up space

Date mg
Open with...

Give access to

Send to

Cut
Copy

e el O
r -1

Delete
- H .
ename

Properties

2 [l Save this message
& Edit

N LR E
X 1
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CHAT DATA RETENTION - 90 DAYS AS OF APRIL 30 2021

Chat messages, filesand meeting notes will be subject to a dataretention
period of 90 days as of April 30, 2021.

This will only impact conversations held in the Chatapplication of Teams (one-
to-oneand group chats)

It doesnotimpact conversations within the Postsection of a Teams Channel.
Data Retention Schedules are required for compliance with UBC Records
Management policies (hxxps://recordsmanagement.ubc.ca/schedules/).

MS Teams’ Chatis intended to be used as a communications platform for casual
conversations. Itis not meant for exchanging confidential or sensitive data, or
for critical/formal decision making.

Links to the files shared in conversations will also be removed at the 90-day

mark; however, the actual files can be found in the MS OneDrive of the original

sender.
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MEETINGS IN TEAMS



MEETINGS IN TEAMS

e Onceyou haveswitchedto Teams Only Mode you can create meetings using Teams instead of Skype for Business

O NOTE: You can use BOTHor EITHERZoom and Teams for meetings at UBC. Teams is replacing Skype for Business only.

0 Teams offers almost the same functionality of Zoom except for providing a dial in number for meeting attendees.
Teams meetings can only be joined via the Teams app or an internet browser.

e Benefits of using Teams for meetings include:

0 Chathistory fromthe meeting is saved (and storedin the Chat section —see THIS SLIDE).

O Ifthe meetingis recurring, the chat, files and meeting notes will all be saved in one spot for ALL meetings in the
series.

O You canalso sharefiles forthe meeting in Teams to be easily accessed by all attendees.
O Meeting Notes are also created automatically with each meeting and accessed via the Chat section

 Note: Onlypeople who are on the original meeting invite to a meeting before notes are created will have
access to them initially. Others can request access, and the owner of the notes will be notified via email.

* Click HERE for more details on taking Notes in Teams Meetings

e See THIS SLIDE for details on Chat data retention



https://support.microsoft.com/en-us/office/take-meeting-notes-in-teams-3eadf032-0ef8-4d60-9e21-0691d317d103

MEETINGS CHATS

sc Cochrane, Sarah 1/20
= You: Thanks Sarah -

Meeting Chats

* Whenyou create a meeting in Teams, the Chat history (and

Vaminh
,'@‘MS Teams Onboarding, Best Practices ... 1/19
‘\ ,"nu: sfe thanks all! Feel free to chat me here or d...

Nt

Files shared and Meeting Notes) from the meeting is saved

inyour Chat with a blueicontoshow itisa meeting chat@

* You canalsojoinameeting from this screen, or from the

Calendar view of Teams (or from the Teams linkin the

meeting invite in Outlook)

* |fthe meetingisrecurring, the chat history, files shared
within the Meetingin Teams and any Meeting notes will be

saved and kept together for all recurring meetings.

e See THISSLIDE for details on Chat data retention I I

L---,
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HOW TO SCHEDULE A MEETING

Via Outlook

From the Home menu, select New Items, then select Teams
Meeting
Then schedule the meeting as you would normally, the Teams Link

is added to the invite

Via Calendarin Teams

The Calendar in Teamsis a replica of your FASmail Outlook
calendar and will show ALL your meetings, not only Teams. It is
synched with FASmail so you can use the same Scheduling
Assistant feature to check availability of other UBC members.
Selectthe +New Meeting button on the top right of the calendar.
Complete meeting details as usual.

NOTE: The Team connection details do not show when you create
the meeting but they will be added to the meetinginvite and to

the calendar link.

2

=1

OVou haven't sent this meeting invitation yet.

[ ]|
=7 subjed |
= Location |MicrosoftTeamsMeeting V| | Rooms... | :
starttime | Mon 2/1/2021 [10:00 Pt ~| O anday .
Endtime  |Mon 2/1/2021 [10:30 Pt -

-

Microsoft Teams meeting

Join on your computer or mobile app

Click here to join the meeting

earn More | Meeting options
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HOW TO SCHEDULE A MEETING - FOR A CHANNEL

Notes:

* Thisis for standard channels only — NOT private channels

* You cancreate a meeting fora channel to send the invite to everyone on the Team, linked & posted to a specific Channel.
* You canonlyselect asingle channel to invite to & post the meetingin.

* Thisisa goodalternative to usinga mailinglistfor a meeting which is open to everyone on the Team or is optional (e.g.
training sessions or info sessions).

How to create a Meeting for A Channel
* Createa New Teams meetingin the Teams
Calendar (see THIS SLIDE)

* Midwaydown, thereisan option to “Add a
channel .

0 Note:Ifthe meeting is applicable to only a subset
of the Team you should NOT add a Channel but
add specific people (in the Add required attendees
field).

0 You can add both specific people AND a channel to
the meeting if certain people are required while
the broader group is optional.

* The meetinglink will be emailed to all
channel members (1) and appearin the
Posts of the channel (2).




HOW TO SCHEDULE A MEETING — WITHIN A CHANNEL*

Go to the channel post section, then EITHER:

0 at thetopright of the channel window, click the “v” next to ===
“Meet” (1) then select “Schedule a meeting” (2) (if you click
“Meet” it will open a meeting window to meet now).

0 Within a message window, select the caledar icon to Schedule a
Meeting \ :
. |

* Fillinthe meeting details as required. -

* The channelis pre-selected in the Channel field (3) but
itcan be removed, or changed if needed.

* Individual attendees can be added (both required
and/oroptional) butis notrequiredin a Channelis
selected.

* Note: Locationisempty butyoucanadda physical meeting
roomon campusaswellifapplicable.

0 Team connection details DO NOT _a‘opear in the body of the New
Meeting form —however these will be added to the meeting invite
sent out to required attendees and channel members.

* The meetinglink willbe emailed to all channel members
(akaall members of the Team) and appearin the Posts
of the channel (see previous slide.

*Note: Thisis only available for standard channels, NOT private channels.



HOW TO SCHEDULE A MEETING - FROM A CHAT

* From asingleor groupchat,inthe new

message bar, select the calendaricon — 1
Schedulea Meeting(1)to opena New -

Meetinginvite.

O The person or people in the chat will be
automatically added to the Required

Attendees field (but this can be edited as gm===mmmmmmmmemmmees
needed). Il

e Completethe meetingdetailsas needed
(and use the scheduling assistant if needed

tofindthe best time) and then click send.

e Theinvitee(s)will receive an email with the

meetingand Teams connection details.
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HOW TO CALL SOMEONE — MEET NOW (VIDEO OR PHONE)

The following methods will start an instant audio or video call to a person or multiple people.

From a Chat (single or group chat) — click the camera or phone icon to start a call
with or without camera (you can turn off or on the camera after the meeting has

started as well)

From a Channel Post (Private or General) - click the camera or phone icon at the

bottom of the message bar OR at the top right of the Channel window to start a

call with or without camera (you can turn off or on the camera after the meeting

has started as well)

* Avideocameraicon will appear nextto the channel name (1) andin the
Channel Posts (2) so anyone who is a member of the channel can click on the

iconto join the meetingas well.

From the Calls application- click on the phone icon on the left vertical menu bar
to open the Calls application. Call someone from your contacts or search for

someone within UBC.

|
|
- ud
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MEETING SETTINGS

When you start a meeting, you can select the following:

Change the meeting name

Camera \ Choose Mute or
on / off background adjust mic
filter

Once in a video or voice call, you can:

Invite other Create breakout

Open a chat
participants l /rooms
LS 0

Raise or Share
lower hand screen

@ -
P
|
-
-—
|

L 5
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ADVANCED TIPS



ADVANCED TIPS — USING SEARCH BAR

/Commands

 Use /commands to move through Teams faster. If you type in “/” into the search
box, all shortcuts & commands will show up!

* Clicktolearn more about commands here.

Usingthe /goto commandto quickly jumpto a different Team or Channel

* Inthe search bar, type “/goto”, thentype the team and channel you’d like to go to.!

@mentioning

* Youcan @mention someone in the search bar and then type your message directly
in the search bar

* Thissends a quick chat message without leaving your current window or project.

Org Charts

* Seethe organizational hierarchy, department members, manager, and how they fit
into the organization. Type /orginto the search bar and select the person you want
toview

* Youcanalsoopena chat with anyone at UBCand click on “Organization” next to
their name.

Keyboard shortcuts — clickthis link fora guide to using Keyboard short cuts with Teams.
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https://support.office.com/en-us/article/Use-commands-in-Teams-88f61508-284d-417f-a53d-9e082164050b
https://support.microsoft.com/en-us/office/keyboard-shortcuts-for-microsoft-teams-2e8e2a70-e8d8-4a19-949b-4c36dd5292d2

USING TEAMS ON THE WEB & MOBILE DEVICES

OntheWeb

 Access Teamsviaa website browser by going to the MS Teams web app at https://teams.microsoft.com.
 Supportedbrowsersare:Internet Explorer 11, Microsoft Edge, latestversion of Chrome and latest version of

Firefox.

Mobile Phones

e ForiPhoneiOS 10.0and later users, go to App store and search for Microsoft Teamsand download the app,
or click here for direct link: https://apps.apple.com/app/id1113153706

e ForAndroid4.4versionand laterusers, go to Play storeand search for Microsoft Teams and download the
app, or click here for direct link: https://play.google.com/store/apps/details?id=com.microsoft.teams

Howto Login

 Loginwithyourfirstname.lasthame@ubc.ca (Faculty/staff) or cwl@student.ubc,ca (Student)

e Enteryour CWL password
* Youshould now be loggedinto Microsoft Teams and ready to connect with your colleagues.


https://teams.microsoft.com/
https://apps.apple.com/app/id1113153706
https://play.google.com/store/apps/details?id=com.microsoft.teams
mailto:firstname.lastname@ubc.ca
mailto:cwl@student.ubc,ca

GUEST ACCESS TO TEAMS

Sometimes you'llwant to collaborate with people who aren't part of UBC or might not be eligible for a FASmail
account.

Addinga Guest to Teams
If the contractor or guest user does not have a firstname.lastname@ubc.ca or cw/@student.ubc.ca email
address they should first associate their email address with a Microsoft account for the best experience. They

canregisterfora free account here (using theirown email): https://account.microsoft.com/account

Then follow these instructions toadd them as a guest to your team.

Guestexperiencein Teams:

The guest experience and permissions in MS Teams are restricted for licensing and security reasons. Learn
more about the differences here.

Check out these videos about the guest experience in Teams:
* Joinateamas a guest

e Joina Teams meeting with guests



https://account.microsoft.com/account
https://support.microsoft.com/en-us/office/add-guests-to-a-team-in-teams-fccb4fa6-f864-4508-bdde-256e7384a14f
https://docs.microsoft.com/en-us/MicrosoftTeams/guest-experience
https://docs.microsoft.com/en-us/microsoft-365/business-video/join-team-guest
https://docs.microsoft.com/en-us/microsoft-365/business-video/join-guest-meeting

MORE HELP -> GET STARTED

Teams Quick Start Guide Provide your feedback on Teams AND submit

Teams FA requests for new applicationsto integrate with

UBC Collaboration Tools comparison Teams / MS365 by filling out THIS FORM (skip to the
end of the form to only submit requests for new

apps).



https://ubcca.sharepoint.com/sites/M365LearningPortal/Shared%20Documents/Forms/AllItems.aspx?id=%2Fsites%2FM365LearningPortal%2FShared%20Documents%2FTeams%20QS%2Epdf&parent=%2Fsites%2FM365LearningPortal%2FShared%20Documents
https://it.ubc.ca/services/email-voice-internet/microsoft-teams/microsoft-teams-faqs
https://it.ubc.ca/sites/it.ubc.ca/files/UBC%20Collaboration%20Tools%20-%20Features%20Comparison%20Chart.pdf
https://ubc.ca1.qualtrics.com/jfe/form/SV_5d2wwJwWnY81lRj

UBC FILE STORAGE OPTIONS & USE CASES

e MSTeams —filescreated forand by groups of people workingtogether(e.g. department, project,

working group)

O General data shared across units at UBC for collaboration purposes — cloud based application
0 Ownership is within the Team where the files are created (stored in Sharepoint)

 OneDrive— personalstorage(similarto Dropbox) which can also be shared with others; will replace
Workspace

O General data accessible by you and others that you provide read or write access to, including non-UBC users —
cloud based application

0 Ownership of files created defaults to OneDrive account holder so if the person leaves UBC unless ownership is
changed others will lose access to files

* K drive/Teamshare - generaland sensitive data accessible by youandyour UBC colleagues —requires
a VPN connection
* Home Drive - filerepository for individual filesonly meantto be accessible by you —requiresa VPN

connection to access
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OneDrive FAQ



https://it.ubc.ca/sites/it.ubc.ca/files/UBC%20Collaboration%20Tools%20-%20Features%20Comparison%20Chart.pdf

WANT MORE? LOGIN TO PORTAL.OFFICE.COM

* Login to http://portal.office.com/ to open your UBC Office 365 accountin a browser

toaccess all 0365 applications, including:

Word, Excel, Powerpoint
Teams

OneDrive

OneNote

Sway

Forms

Whiteboard

O O O O o o o©°

Note: not all applications are fully available to UBC currently

0365 Support — Office Applications Help & Training



http://portal.office.com/
https://support.microsoft.com/en-us/office/office-apps-help-and-training-8b9042aa-7507-477b-b294-1b178b47c8e5






